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Right now, you’re probably standing in a small,
cramped bookstore aisle, trying to decide

whether or not you should buy this book.
You’re probably thinking to yourself,

“What is this book going to teach me?
Do I want to learn what this book is
teaching? Can I learn what’s in this
book? How much of Flash do I 
really want or need to know?” These
are all perfectly valid questions.
Questions which I most assuredly
can’t answer in this first paragraph.
So bear with me, and read a little
more of this first chapter as I outline
the topics this book will cover, what

you will be learning, and how you will
go about doing it. You may want to go

find a place to sit down first, though. ;-)
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What Is This Book?
In its barest essence, the goal of this book is to teach you intermediate-level Flash. (See the next section,
“What Is ‘Beyond the Basics?’,” for more about what the definition of “intermediate” is.) Expanding
upon that goal, this book aims to teach you intermediate-level Flash in the context of building things. In
this book, you will learn how to use Flash MX 2004 (you can use Flash MX Professional 2004 as well)
to construct the following (partial list):

• Scrolling text (text that is loaded into Flash from an external text file and has its appearance
modified using Cascading Style Sheets [CSS])

• Dynamic slideshow (from external JPG files that are loaded into your Flash movie)

• Feedback form

• MP3 jukebox

• Streaming video player

• Navigation menu

• Preloader

• Macromedia Flash Player 7 detector

• Much, much, more

To learn how to build these things, you should already be very comfortable and familiar with basic 
Flash concepts such as the tools, animation techniques of motion and shape tweening, various types
of symbols and what their differences are, at least basic ActionScript knowledge such as stop, play,
goto, and loadMovie, what variables are, and so forth. For a good idea of what this book assumes that
your Flash MX 2004 knowledge base is, see the lynda.com H•O•T book, Macromedia Flash MX 2004
Hands-On-Training. Scan through the table of contents of that book and make sure that you are very
familiar with the topics that book covers. From a skill-level perspective, this book starts where that
book leaves off, and it ends where an “advanced” Flash MX 2004 book would pick up.

By the end of this book, you will have covered how to take all these separate pieces (MP3 jukebox,
streaming video player, and so forth) and integrate them into a unified, cohesive Web site. This book
focuses on “modular” Flash MX 2004 construction—that is, I emphasize constructing your Flash MX
2004 content in a way where you can treat the separate pieces of a Web site as individual modules. 
A module can play and function by itself, or it can easily be plugged into a Web site for added func-
tionality. As I’ll describe later in this chapter, this gives you—a Flash MX 2004 designer/developer—
great freedom when creating your content because it can be used and reused for multiple purposes.
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What Is “Beyond the Basics”?
The term “beyond the basics” applies to the next level of education after the basic “Hands-On Training”
series. What does that mean? Essentially, “Beyond the Basics” is intermediate-level, whereas the basic
“Hands-On Training” series is beginner-level. To get the most out of this book, you should have a firm
grasp of beginner-level Flash development. You should already know the Flash interface including:

• How to access the various panels

• How to use the different drawing tools

• How to animate using motion and shape tweens

• How to work with and create the different types of symbols, as well as how the symbols differ
from each other

• How to import assets (vectors, bitmaps, and so forth) into your project

• How to work with text and the different types of text fields

• Basic ActionScript such as stop, play, goto, and loadMovie

• Variables

• Working with sound and video

• Publishing your movies

Having a solid grasp of these beginner-level Flash MX 2004 concepts will allow you to absorb the
information in this book, as best as possible.

One of the most overlooked areas of Flash MX 2004 training is the intermediate-level. If you look
around on the bookshelves for other Flash MX 2004 training books, you’ll see a plethora of material
that covers beginner-level and advanced-level Flash MX 2004 learning, but a vast desert exists where
the “intermediate” Flash MX 2004 training should be. Did I say desert? Heck, I meant Death Valley.
There is very, very little material that allows the average Flash MX 2004 student to gracefully navigate
the chasm that exists between intro- and advanced-level Flash MX 2004. This book is designed specif-
ically to bridge that gap by teaching you not only intermediate-level Flash MX 2004 content, but best
development practices, thinking modularly, and site development as well.

So if you’re not quite ready to enter the “advanced” Flash MX 2004 realm where you learn about
arrays, data binding, and the like, but you’re ready to move past the basics and into more challenging
Flash MX 2004 design and development, calmly rise from your seat and advance slowly (walk, don’t
run) to the checkout counter with this book in hand.
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Modular, Modular, Modular
Picture this. You design and build a Web site for a client. You build for them a slideshow to show off
their products, create some scrolling text about the company and the products they sell, develop a
video player, make a menu system so the viewer can navigate around the site, and even add a little
music player. Then, a month later, imagine you’re contacted by a company who saw the previous site
you did and wants you to build a site for them. This potential client would also like similar features—
slideshow, video player, menu, music, and so forth—but they’re in a real hurry, and they need the site
done yesterday. Taking a deep breath, you calmly explain to the client that Flash sites are complex,
can’t be done overnight, and require lots of ActionScript programming to customize their features. You
thank the client for complimenting you on the site you previously built but clarify to them that to build a
new Web site—even though the features are similar—would still take a lot of time to construct because
everything needs to be customized. Or does it?

In this book, the focus is not only to show you intermediate-level ActionScript and how to build a Flash
MX 2004–based Web site, but how to do it in a modular fashion. Instead of building a customized
Web site where everything is tied together and reliant upon each other, you’ll learn how to break the
Web site up into logical, stand-alone modules. These modules will work the same in one site as they
could in another, or even be removed from a Web site completely and played by themselves (like on a
PDA [Personal Data Assistant] device such as a Pocket PC or even burned onto a CD-ROM or
attached to an e-mail). This provides you with an extraordinary amount of freedom because it allows you
to design a module once, then reuse it for multiple purposes. This comes at a price, however. To
construct a modular Web site takes a little extra pre-planning when building those modules, so that they
will function the same in a Web site as they would outside of it. But in exchange for extra pre-planning,
you gain—in return—the satisfaction of turning to the aforementioned hypothetical client, and saying,
“Sure, I can have something for you by tomorrow.” ;-)

What’s New in Flash MX 2004
As with any product upgrade, Flash MX 2004 introduced a huge list of improvements, modifications,
and additions. Probably the biggest change is that Macromedia split Flash into two “flavors”: Flash MX
2004 and Flash MX Professional 2004. In essence, they are the same product. (Even when you pur-
chase Flash, everyone gets the same program shipped to them. But if you purchased and thereby enter
a “Professional” serial number, it then “unlocks” the professional features.) The following table describes
a few of the new features, and whether those features are only available in the “Professional” version.
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New Features

Flash MX 
Flash MX Professional 

Feature Description 2004 2004

Timeline Allows you to easily create standard animations in √ √
effects a “wizard” interface. Easily create animations such 

as “Blur,” “Drop Shadow,” and “Explode.”

Behaviors Easily add some common actions with one √ √
click. Behaviors allows you to apply prebuilt 
ActionScript functionality to keyframes, button 
symbols, or movie clips symbols.

PDF & EPS Easily import and integrate content into your √ √
file support Flash MX 2004 movies with support for high-

quality PDF and EPS files from such programs 
as Adobe Acrobat and Adobe Illustrator.

Integrated Help Help is now built into Flash MX 2004 in its own √ √
panel! By simply pressing F1 on your keyboard, 
you can open the Help panel. From there, you 
can search through the Help documentation, 
or by clicking on the How Do I tab, you can read 
step-by-step instructions for completing common 
tasks. The Help documentation is also frequently 
updated by Macromedia. Click the Update button 
at the top of the Help panel to download the latest 
Help documentation from Macromedia’s servers!

Spell checking Yes. It’s finally here. You can now spell check the √ √
and search/ text in your Flash MX 2004 movie! The extremely
replace powerful search and replace feature allows you 

to perform search and replace across actions, the 
Library, the Stage, layers, fonts, text fields…the list 
goes on and on. A very powerful new addition 
and a real butt-saver.

Video Import Provides you with a “wizard” interface when importing √ √
Wizard video. The Video Import Wizard allows you to edit 

your video by clipping out unwanted segments, 
change the hue and value of the video, and set up 
preset encoding and processing settings so the 
same settings can be easily applied to other videos 
that you import into your Flash projects.

continues on next page
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New Features continued

Flash MX 
Flash MX Professional 

Feature Description 2004 2004

External Macromedia Flash Player 7 now supports progressive √ √
FLV support downloading (via an HTTP Web server) of external 

FLV files, using ActionScript, into your Flash MX 
2004 projects! A similar feature was also available 
for Macromedia Flash Player 6, but it supported 
FLV streaming only if the project was served from 
the Macromedia Flash Communication Server. 
Now, in Macromedia Flash Player 7, a FLV can be 
progressively downloaded from a standard Web 
server without requiring any extra server software. 
The neat thing about this is that the video will 
actually start playing while it is still downloading. 
Although this may sound like a small detail, it’s 
actually a big deal because you can now have 
video in your Flash project that is not limited to 
file size, or video length, and has a better video 
playback quality/speed, too!

Aliased text This is a biggie for Flash designers of the past. √ √
Flash MX 2004 now has an Alias Text button in 
the Properties inspector that allows you to, of course, 
alias (remove the smoothing [anti-aliasing]) around 
text. This allows you to have small text point sizes 
while still maintaining readability. The aliasing of 
your text is assured if you use the Alias Text feature 
in conjunction with View > Snapping > Snap to 
Pixels. This will prevent all fonts, even the tradition-
ally troublesome bitmap fonts, from becoming 
blurry on playback.

Improved Macromedia touts a performance increase of two √ √
performance to eight times that of Flash MX, for projects that 

are created in Flash MX 2004 and viewed in 
Macromedia Flash Player 7. This includes Flash 
playback performance as well as faster video 
performance at full frame rates. Huzzah!

continues on next page
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New Features continued

Flash MX 
Flash MX Professional 

Feature Description 2004 2004

ActionScript 2.0 ActionScript now more closely adheres to ECMA √ √
(European Computer Manufacturers Association) 
standards with the introduction of AS 2.0. AS 2.0 
allows experienced programmers to more easily create 
robust code using object-oriented programming. You’ll 
see some examples of AS 2.0 being used in this book.

Flash video A separate plug-in that allows you to give FLV √
exporter plug-in export functionality to third-party video editing/

compression applications such as Apple Final Cut 
Pro, Discreet Cleaner, Avid Xpress/Media Composer, 
and so forth. This FLV exporter plug-in also allows 
you to have higher-quality video in your Flash MX 
2004 projects.

Advanced Use advanced components such as media compo- √
components nents for audio and video playback, as well as data 

components for easily integrating data-driven content 
into your Flash MX 2004 projects.

History panel/ Flash MX 2004 now has a History panel! The √ √
commands History panel keeps track of the previous 100 

changes (by default—but you can change this in 
the preferences) you’ve made to a project. You can 
easily move back and forth between modifications by 
clicking on a change in the panel. As if that wasn’t 
enough, you can also select a series of changes in 
the History panel and convert it into a reusable 
command, easily accessible from the Commands
menu. Wowzers!

CSS support in Text fields with HTML support enabled can now √ √
HTML text fields utilize Cascading Style Sheet (CSS) styles! This 

provides you with even more options when styling 
your text and also allows you the added benefit of 
sharing external CSS files with the HTML and 
Flash MX 2004 portions of a Web site.
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These are just a few of the new features that have been added to both Flash MX 2004 and Flash MX
Professional 2004. For a list of many more additions and improvements, visit Macromedia’s Flash MX
2004 Features page here:

http://www.macromedia.com/software/flash/productinfo/features/

This book does not cover any of the features that are specific to the Flash MX Professional 2004 version.
As you can see in the previous table, many of the specialized features found in the Professional version
truly are professional. Don’t worry, though—there are more than enough capabilities in the “standard”
version of Flash to enable you build even the most complex of Web sites.

Upgrading from MX to MX 2004?
Sometimes, upgrading your software from an old version to a newer one can be a steep, slippery slope.
Fortunately, that really isn’t the case if you’re upgrading from Flash MX to Flash MX 2004. Oh, sure
there are new features and additions (as I mentioned in the last section) that you need to learn, but in
terms of “gotchas” or caveats, there aren’t that many. Obviously, not all differences are listed here, but
here are a few items that you need to be aware of if you’re upgrading from Flash MX:

• Insert > Convert to Symbol is now located at Modify > Convert to Symbol. In fact, quite a few
items have been reorganized in the main menu structure, many of which have been nested in sub-
menus within the main menu. These changes were introduced by Macromedia to help increase the
usability of navigating around the plethora of features.

• When you launch Flash MX 2004, you’ll immediately recognize the newly added “Start Page.” The
Start Page is a window that opens when you launch Flash MX 2004, and it allows you to quickly
perform a variety of common tasks. From the Start Page, you can create a new blank FLA, create
a FLA based on a template, open a previously opened FLA, and more. Depending on whom you
talk to, the Start Page is either a great new addition or an annoyance. Give it a try yourself and
see what you think.

• The Show Streaming feature is now called Simulate Download. This will allow you to test your
Flash MX 2004 movie to see how it would appear if accessed using various connection speeds.
However, in Flash MX, show streaming would not work if using loadMovie. All assets loaded using
loadMovie would ignore show streaming and you therefore would have no idea how your Flash
movie would play if accessed using different connection speeds. In Flash MX 2004, Simulate
Download now will accurately simulate the download of assets that are loaded using loadMovie
(and its replacement, the MovieClipLoader). Yayy!
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• Some of you might have wrestled with a bug in Flash MX that caused bitmap graphics to shift,
split, or wiggle if you animated other graphics on top of them. This bug has now been fixed in
Flash MX 2004 when publishing for Macromedia Flash Player 7.

• The Scrollbar component has been removed from Flash MX 2004. Instead it has been replaced
by its successor, the TextArea component.

• Components have been reworked in Flash MX 2004. They are now referred to as V2 components.
Because of the new component framework, when you add a component to your project, it can
easily—and instantly—increase the file size of your movie by at least 40 kilobytes. The idea behind
that is that even though the initial increase in file size may be drastic, adding more components
should only increase the file size by small amounts. It’s one of those “better in the long run”
arrangements.

• When working in the Actions panel, the ActionScript Normal mode has been removed. Instead,
the Actions panel is now permanently set in Expert mode, meaning that you just manually type
the actions in the Actions panel, or just double-click an action from the Actions toolbox.

• ActionScript is now case-sensitive. In other words if, in Flash MX, you defined a variable myVar,
you could later refer to that variable as myvar (notice the lack of capitalization of the letter “v”) and
everything would still work. However, because Flash MX 2004 is case-sensitive, Flash would see
those as two different variables, and the script would break. When writing ActionScript, be aware
of how you use capitalization in your scripts.

To see a complete list of the new additions to both Flash MX 2004 and Flash MX Professional 2004,
point your Web browser to the following URL:

http://www.macromedia.com/software/flash/productinfo/upgrade_center/extended_list.html

You can also read a great article on Macromedia’s Web site about migrating from Flash MX to Flash
MX 2004 here:

http://www.macromedia.com/devnet/mx/flash/articles/migrate_flashmx2004_print.html
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What Am I Building?

In this opening exercise, you will examine the online L.A. Eyeworks Web site, which is the culminating
project that you will build at the end of this book. At the beginning of each chapter, you will get to see
the finished result of what you’re building before you actually start building it. That way, as you’re
assembling a module, you’ll already have a clear understanding of what the final result looks like and
how it behaves.

First you need to make sure you have the latest version of the Macromedia Flash Player.

1.

1. Open your preferred browser and type in this URL: 

http://www.macromedia.com/go/getflashplayer

2. Follow the instructions to download and install the latest version of the Macromedia 
Flash Player. This will ensure that you’re using an up-to-date version of the Macromedia 
Flash plug-in.

3. After you’ve finished installing the Macromedia Flash Player 7, enter this URL in your
preferred Web browser: 

http://www.lynda.com/flashbtb/laeyeworks/

As you can see, when the site finishes loading, there are quite a few things going on. 
You’ll see the main menu navigation bar at the top of the page, a splash graphic in the
middle, and a music player at the bottom of the page. The music is turned off by default 
so that viewers aren’t inundated with sound as soon as they visit the Web site. If you 
want to listen to music as you browse through the site, click the Play button in the 
lower-left corner of the site.
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4. Click the (about us) button at the top of the page in the navigation bar. This will load the About Us
section. Notice that the About Us section has a submenu and is divided up into three subsections:
our history, our staff, and video.

The our history and our staff subsections both contain scrolling text. (You can scroll the text up 
or down by clicking on the up and down arrow buttons at the right side of the page.) One of the
interesting things about this text, however, is that it is styled using Cascading Style Sheets (CSS)!
This is a new feature in Flash MX 2004. Cascading Style Sheets have traditionally been a way to
define the style and layout of “standard” HTML-based Web pages. But now, Flash can use CSS 
to style text as well! You’ll learn more about this feature in later chapters.

5. Click the (our staff) subsection. Notice how, integrated into the text, are two animated images. This
demonstrates another new Flash MX 2004 feature: inline JPG or SWF files. You can now integrate into
the text (inline) within a dynamic (HTML-enabled) text field, JPG or SWF graphics. Neat!
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6. Click the (video) subsection button. Here you will see a video that will start playing. (Note: If you
have a slow Internet connection, it will take longer for the video to start playing.)

This is actually an external FLV file (meaning, it wasn’t placed in the Flash MX 2004 movie; it’s a
separate FLV file that exists apart from the other files) that is being streamed off of a Web server 
(no fancy server software required), using ActionScript, into the About Us section. This is also a 
new feature to Macromedia Flash Player 7. (I’ll talk all about this new feature, and its advantages, 
in Chapter 11, “Building a Video Player.”) Notice that below the video has a pause button so that 
the viewer can pause/play the streaming video. Next to that is a progress slider that displays the 
playback progress of the playing video.

Next, you’re going to explore some of the other sections.
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7. Click the (frames) button in the navigation bar at the top. This will load in the frames section, which
is an interactive slideshow that allows you to view a sampling of 10 frames. Click the Next button to
advance to the next image, or choose the Previous button to go back to the previous image.

Notice that to the left of each of the images is an updated description of each pair of frames. Below
the frames’ images are buttons to navigate backward and forward through the slideshow. Between
the buttons is a bit of text that informs you—out of how many frames total—which frame you’re cur-
rently viewing. The interesting thing about this slideshow is that each frame image is an external JPG
file, and each text description is an external TXT file (that also gets styled using CSS). These files are
dynamically loaded into the Macromedia Flash SWF file and displayed as the user clicks through the
slideshow. You will learn how to build this slideshow, as well as why it is constructed in this manner,
in Chapter 7, “ Building a Slideshow.”
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8. Next, click the (locations) button from the navigation bar. This will load an interactive map. Clicking
on one of the stars on the map of Los Angeles (and surrounding areas) will load more information
about that particular L.A. Eyeworks location. Similar to the Our Staff subsection in About Us, the
location detail displays an inline, animated SWF file, accompanied by CSS-styled text.

9. From the main menu navigation bar, click the (contact us) button. This will load a feedback form
where you can enter your name, email address, and comments. Once you have entered your infor-
mation in this form, click the submit button.
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If you entered information in each field, when you click the submit button you will be presented with this
“thank you” message. Notice how your name (or whatever you entered in the name field) has been
inserted into this message. When you get to this part, you’ll be surprised how easy it is to do this. :-) If
you didn’t enter information in each field, when you clicked the submit button you would have been
presented with an error message. This error message would politely inform you that you forgot to fill out
each field and would provide you with a back button so you could fix the error of your ways.

10. Lastly, click the play button down at the lower-left corner of the site window. This will begin down-
loading and playing an MP3. Like the video player module, this MP3 player progressively downloads an
MP3 from the Web server. Not only that, but this MP3 player also displays the artist and track name of
the currently playing MP3. (This information is retrieved from the MP3’s ID3 tags [more on that later].)
It also allows you to change the currently playing music track by clicking on the next track and previous
track buttons, and adjust the volume of the playing music by dragging the volume slider. It’s one sexy
bit of Flash MX 2004 ActionScript that will wow your neighbors and amaze your friends.
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So as you can see in this brief site tour, there’s a lot going on in this site. During the construction of
this Web site, you’ll be introduced to a wide array of topics and ideas. Everything ranging from site
development techniques, to workflow suggestions, to a multitude of ActionScript objects (classes),
variables (properties) and functions (methods). As you begin to learn these new techniques and
ActionScript, each step will be explained in detail.

Updates
At the time of this book’s publication, there is only one update for Flash MX 2004. Update 7.0.1,
available for both Macintosh and Windows operating systems, is for users of both Flash MX 2004 
and Flash MX Professional 2004. The 7.0.1 update addresses many items, but I can safely say, go
download it now! You can easily download the 7.0.1 update by pointing your preferred Web browser
to the following URL:

http://www.macromedia.com/support/flash/downloads.html

If you would like to see a list of the items affected by the 7.0.1 updater, point your Web browser 
to this URL:

http://www.macromedia.com/support/documentation/en/flash/mx2004/
releasenotes.html#Update

In the next chapter, you will begin to learn about Web site development/construction techniques, as
well as which file formats work best when importing graphics from a separate image-editing program.
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